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1 - Introduction to SI Xplorer (Beta)
SI Xplorer is a standalone application based on the Layer StackupWizard implemented in
SIwave and HFSS 3D layout. For help with Layer StackupWizard in the context of those
applications, please consult the SIwave or HFSS 3D Layout documentation.

SI Xplorer has all of the capabilities of Layer StackupWizard, as well as:

l Dynamic computation and update of Z0/Zdiff value stackup parameters (signal layers only)
l Persistent view of conductor cross-section defined in the w-element panel
l Persistent view of impedance and w-element plots
l Ability to define sweeps for impedance plots
l Support for project variables
l Ability to define and edit padstacks
l Ability to define new via breakouts as independent 3D Layout designs
l EDB cell view for visualization, editing padstack instances, and defining backdrills
l Ability to run HFSS simulation setups
l Network Data Explorer workspace for visualizing results

SI Xplorer also supports the use of variables.

Launching SI Xplorer
Launch SI Xplorer from its executable file AnsysSIXplorer.exe from the Windows or Linux
installation folder:

l .../ansys_inc/v252/AnsysEM

l "...\ANSYS Inc\v252\AnsysEM

The SI Xplorer Window

Introduction to SI Xplorer 1-1
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The SI Xplorer window contains the following areas:

1. Menu Bar – provides access to options for importing and exporting files, defining multizone
stackups, performing a simulation, viewing results, and customizing the view.
See: SI Xplorer Menu Bar Options.

2. Stackup / Padstacks – displays a visual of the layer stackup and allows you to edit layer
properties. Selecting a layer in the list also selects it for analysis in the ImpedanceWizard.

3. Impedance / Via Wizard – use the tabs to select either the Impedance Wizard or Via
Wizard.
l The Impedance Wizard contains a calculator for impedance, differential impedance, and
trace width/pitch. It also allows you to change w-element settings and export w-element
information. Changes made in the ImpedanceWizard display in the Plots and
Messages area asW-Element Plots and Impedance Plots.

l The Via Wizard allows you to define, visualize, and edit padstacks.
4. Plots and Messages – depending on which tab is selected, displays w-element plots,

impedance plots, the Network Data Explorer, a progress monitor, or the message manager.
The plots update dynamically as you make inputs, and can be exported. See: Viewing and
Exporting Plots in SI Xplorer.

Introduction to SI Xplorer 1-2
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Note:

Impedance Plots only update dynamically when Enable Dynamic Update is
selected in the Impedance Wizard area.

5. Status Bar – displays a progress bar while actions are in progress.

You can resize each area as appropriate by dragging its borders. Each area is explained in
further detail in the topics below.

Loading Files into SI Xplorer
SI Xplorer can load an HFSS 3D Layout Design (*.aedt) or EDB Definition file (*.def).

Important:

SI Xplorer can only open *.aedt projects that were created in SI Xplorer.

From the Command Line

To open SI Xplorer with a file already loaded, pass an argument to that file's path. For Example:

C:\Program Files\ANSYS Inc\v252\AnsysEM\Win64\AnsysSIXplorer.exe
"C:\Users\jdoe\Documents\SAMPLEFILES\MyFile.aedt"

From the GUI

SI Xplorer supports the following design types:

l Ansys Electronics Desktop (*.aedt)
l EDB Definition File (*.def)

Additionally, it supports the following stackup file types:

l IPC2581 Design Files (*.xml, *.cvg)
l SIwave Control File (*.stk)
l XML Control File (*.xml)

To open an *.aedt file:

l Click File > Open Project.

To load any of the other file types:

l Click File > Import > [File Type].

Introduction to SI Xplorer 1-3
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SI Xplorer Menu Bar Options
The SI Xplorer menu bar contains the following submenus:

l File
l Multizone
l Project
l Simulation
l Results
l View
l Help

File Submenu

The Filemenu contains the following options:

l Open Project – allows you to open Ansys Electronics Desktop files (*.aedt).
l Save – saves the current *.aedt file.
l Save As – allows you to specify a name and location to save a new *.aedt file.
l Import – allows you to import an EDB definition file (*.edb), IPC2581 design files (*.xml,
*.cvg), or layer Stackup files (*.xml, *.stk).

l Export – allows you to export to EDB, IPC2581, Stackup XML, Stackup STK, or Stackup
CSV.

l Recent File – displays a list of recently opened files, if any exist.
l Exit – closes SI Xplorer.

Multizone Submenu
Multizone menu options become available when you select the Multizone stackup type in
SI Xplorer. See: Modifying the Layer Stackup using SI Xplorer.

Introduction to SI Xplorer 1-4
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TheMultizonemenu includes the following options:

l Add – Adds a new multizone in a new sheet.
l Remove – Removes a multizone.
l Create from Selection – Creates a new multizone based on the selection.

Project Submenu

The Project submenu contains options to Configure Stackup, Configure Via, or configure
Project Variables.

Configure Stackup

The Configure Stackupmenu option launches the Select Stackup Configuration window:

You can set the following default options:

l Number of signal layers – enter a value.
l Signal layer material – select a material from the drop-down menu.

Introduction to SI Xplorer 1-5
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l Dielectric layer material – select a material from the drop-down menu.
l Set conformal coat – select the check box to enable.

ClickOK to save the default options.

Configure Via

The Configure Viamenu option launches the Configure Via window:

See: Configuring Vias.

Introduction to SI Xplorer 1-6
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Project Variables

The Project Variablesmenu option launches the Properties window, on the Project Variables
tab:

See: Setting Project Variables.

Simulation Submenu

The Simulationmenu includes the following options:

Introduction to SI Xplorer 1-7
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l Add HFSS Solution Setup – Allows you to add either an Auto or Advanced HFSS solution
setup.

l Add Frequency Sweep – Allows you to add a Frequency Sweep to an existing
HFSS solution setup.

l Delete HFSS Solution Setup – Removes a solution setup.
l Delete Frequency Sweep – Removes a Frequency Sweep.
l Validation Check – Verifies that the design is ready for simulation.
l Design Settings – Allows you to change design settings for simulation.
l Analyze – Runs either the Active Setup or All Setups.

Results Submenu

The Resultsmenu allows you to invalidate solution results or show the results in Network Data
Explorer. Either action can be applied to the Active Setup or to All Setups.

View Submenu

The Viewmenu contains the following options:

l View Design in Fill Mode – when selected, the design displays as solid. When deselected,
the design displays as wireframe.

l Toolbars and Docking Windows – contains the following display options:
l Reset Workspaces – allows you to return SI Xplorer to its default view.
l Auto Toggle Workspaces – allows you to synchronize workspaces. When you click on
the ImpedanceWizard, the Stackup Layers andW-element Plots workspaces become
active. When you click the Via Wizard, the Padstack Editor and Network Data Explorer
workspaces become active.

l Status Bar – toggles the status bar at the bottom of SI Xplorer.

Help Submenu

Introduction to SI Xplorer 1-8
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The Helpmenu allows you to retrieve software information by clicking About Ansys SI Xplorer.

You can also click Help Contents to navigate to the SI Xplorer online help.

Setting SI Xplorer Options
The SI Xplorer menu bar can be used to set a number of options.

The following topics explain these in further detail:

l Configuring Vias
l Setting Project Variables

Setting Project Variables
A variable is a numerical value, mathematical expression, or mathematical function that can be
assigned to a design parameter. You can assign a variable to any dimension, material property,
or output value in SI Xplorer. Variables are useful if you expect to change a parameter often, or
expect to use the same parameter value often.

Access project variables in SI Xplorer by clicking Project > Project Variables.

The Properties window appears, on the Project Variables tab:

Introduction to SI Xplorer 1-9
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Adding Project Variables
1. From the Project Variables tab, click Add.

The Add Property dialog box appears.

2. Enter information for the variable, as applicable:
l Name – project variable names must start with the dollar sign symbol ($), followed by a
letter. The name can contain alphanumeric characters and underscores (_).

l Variable Type – use the Variable and Separatorradio buttons to select the variable type.

Introduction to SI Xplorer 1-10
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Your selection impacts which properties you can edit:

Variable Type Editable Properties

Variable Unit Type, Units, Value.

Separator Name only. A separator variable provides a bolded name for a
blank line to facilitate grouping variables in variable lists.

l Unit Type – for Variables, use the drop-down menu to select a type from the list (e.g.,
Charge, Density, Energy, et cetera). “None” is the default.

When you select a Unit Type, the choices in drop-down menu for the Units text box adapt
to that unit type. For example, selecting Length as the Unit Type causes the Unit menu to
show a range of metric and english units for length. Similarly, if you select the Unit Type
as Resistance, the Units drop down lists a range of standard Ohm units.

l Units – for Variables, use the drop-down menu to select a unit of measure.
l Value – for Variables, enter a number, variable, or mathematical expression. The quantity
entered will be the current (or default) value for the variable. If the mathematical
expression includes a reference to an existing variable, this variable is treated as a
dependent variable. The units for a dependent variable will automatically change to those
of the independent variable on which the value depends.

Warning:

If you include the variable's units in its definition (in the Value text box), do not
include the variable's units when you enter the variable name for a parameter
value.

3. ClickOK.
The new variable appears in the list. You can sort project variables by clicking the Name
column header. Clicking once sorts them in ascending order, noted by a triangle pointing up.
Clicking against sorts in descending order, noted by a triangle pointing down. Clicking a third
time sorts in original order, with no triangle.

4. If appropriate, use the check boxes to designate a variable as Read-only or Hidden.
l Read-only – when selected, the variable's name, value, unit, and description cannot be
modified.

l Hidden – hidden variables do not appear in the Properties window unless Show Hidden
is selected.

5. Click Apply to apply changes.
6. ClickOK to exit the window.

Editing Project Variables

Introduction to SI Xplorer 1-11
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To edit a project variable:

1. Access Project Variables.
2. Select the variable you want to edit and click Edit.
3. Change the properties as appropriate and clickOK.

Removing Project Variables

To remove a project variable:

1. Access Project Variables.
2. Click Remove.

A drop-down menu appears.

3. Remove one or more variables:
l To remove a specific variable, ensure it is selected and click  Remove Selected.
l To remove all unused variables, click Remove All Unused.
l To force the removal of all unused variables, including those in the project's undo/redo
history, click Force Remove All Unused.

Introduction to SI Xplorer 1-12
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2 - Modifying the Layer Stackup
The Stackup Layers area of SI Xplorer allows you to add and remove layers, edit layer
properties, edit HFSS etch factor, and change surface roughness.

The right side displays an image of the layer stack. The left side displays options for altering it:

l Stackup – use the drop-down menus to change the stackup Type or Units. See: Multizone
Stackup below.

l Layers List – allows you to select rows, highlighting them in the stack and selecting them
for impedance or w-element analysis. Each cell in the table can be edited, allowing you to
quickly change a layer's name, type, material, fill, and thickness. You can also use the check
boxes to enable HFSS etch factor or surface roughness for a layer.

l Layer – contains options for inserting new layers and removing existing layers. The drop-
down menu allows you to select all layers, select dielectric layers, or select signal layers.
You can then bulk edit these layers' properties in the Edit Selected area.

Modifying the Layer Stackup 2-1
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l Edit Selected – allows you to edit a single layer's properties, or the properties of multiple
layers selected using the layer selection drop-down menu.
l Etch – when Etch is selected for a layer, click the Etch button to open the HFSS Etch
Factor window:

See: Setting HFSS Etch Factor.

l Rough – when Rough is selected for a layer, click the Roughness button to open the
Surface Roughness Model window:

Modifying the Layer Stackup 2-2

Ansys Electromagnetics Suite 2025 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



SI Xplorer Help

For the layer's Top, Bottom, and Side, select the roughness model and enter an
appropriate parameters.

TheGroissmodel used within Ansys Electronics products is a modified version of the
original Groiss model. It is causal.

The Huraymodel is also a causal model. See: Huray Surface Roughness Model.

Note:

HFSS Etch Factor and Surface Roughness can be edited when one or more signal
layers is selected. Selecting dielectric layers disables these options.

Multizone Stackup (Beta)

By default, the Stackup Layers area displays one tab: the Primary tab. SI Xplorer can also
divide the layer stack into multiple zones.

To use this feature:

1. Use the Type drop-down menu to selectMultizone.
The Stackup Layers area updates to show theMultizone tab:

Modifying the Layer Stackup 2-3
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2. Add or remove zones using theMultizonemenu on the menu bar.

A Zone# tab appears for each new zone:

TheMultizone tab updates to include the new zones:

Modifying the Layer Stackup 2-4
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The left side allows you to assign layers to zones. The right side contains a color key.

3. Use the Zone# check boxes to assign layers to zones.

One assigned, layers appear in their zone tab(s). Each Zone# tab looks and functions like
the Primary tab.

Note:

By default, Enable Dynamic Update is selected in the Impedance Wizard.

When any change is made in the Layer Stackup window:

l The design updates.
l Impedance and differential impedance are recalculated.
l W-element plots are recalculated and replotted.

To disable these recalculations, deselect Enable Dynamic Update.

Modifying the Layer Stackup 2-5
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3 - Using the Impedance Wizard
The Impedance Wizard displays by default when SI Xplorer is opened.

If it has been closed, select View > Toolbars and Docking Windows > Reset Workspaces.
Then, ensure the Impedance Wizard tab is selected:

After you have configured stackup layers, the Impedance Wizard allows you to:

l Calculate Impedance
l Calculate Differential Impedance
l Calculate Trace Width and Pitch
l Perform W-element Analysis

Additionally, calculations made using the ImpedanceWizard can be used to:

l View Impedance Plots
l View IL/RL and FEXT/NEXT Plots

Using the Impedance Wizard 3-1
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Note:

By default, Enable Dynamic Update is selected in the Impedance Wizard.

When any change is made in the Layer Stackup window:

l The design updates.
l Impedance and differential impedance are recalculated.
l W-element plots are recalculated and replotted.

To disable these recalculations, deselect Enable Dynamic Update.

Calculating Impedance (Z0)
Using SI Xplorer's Impedance Wizard, you can configure and perform an impedance
calculation.

Prerequisites:

l Use the Stackup Layers pane to select a layer. The Selected Layer Name field displays
the currently selected layer.

l Use the Trace Cross Section button to open the HFSS Etch Factor window.
l Use the Frequency drop-down menu to select the frequency used for impedance
calculations.

To calculate impedance:

1. Select the Analysis tab.
2. Select the Single Ended Nets tab.
3. Select your reference layers.
4. From the Trace Width field, enter a trace width.
5. If you wish to define coplanar waveguide reference planes, select Define CPW ref. planes

(edge-to-edge) to enable additional options.
l You may select Left plane spacing, Right plane spacing, or both.
l For W-element export, selecting Left plane spacingmeans that aggressors may only be
added to the right of a victim trace; any traces to the left are removed. Selecting Right
plane spacingmeans that aggressors may only be added to the left of a victim trace; any
traces to the right are removed.

6. Click Compute Z0.

Using the Impedance Wizard 3-2
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7. The Z0 field updates to show the result.

Calculating Differential Impedance (Zdiff)
Using SI Xplorer's Impedance Wizard, you can configure and perform a differential impedance
calculation.

Prerequisites:

l Use the Stackup Layers pane to select a layer. The Selected Layer Name field displays
the currently selected layer.

l Use the Trace Cross Section button to open the HFSS Etch Factor window.
l Use the Frequency drop-down menu to select the frequency used for differential
impedance calculations.

To calculate differential impedance:

1. Select the Analysis tab.
2. Select the Differential Nets tab.
3. Select your reference layers.
4. From the Trace Width and Trace Pitch fields, enter a trace width and pitch.
5. If you wish to define coplanar waveguide reference planes, select Define CPW ref. planes

(edge-to-edge) to enable additional options.
l You may select Left plane spacing, Right plane spacing, or both.
l For W-element export, selecting Left plane spacingmeans that aggressors may only be
added to the right of a victim trace; any traces to the left are removed. Selecting Right
plane spacingmeans that aggressors may only be added to the left of a victim trace; any
traces to the right are removed.

Using the Impedance Wizard 3-3
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6. Click Compute Zdiff.
7. The Zdiff field updates to show the result.

Calculating Trace Width and Pitch
Using SI Xplorer's Impedance Wizard, you can configure and perform a trace width or trace
pitch calculation.

You can then push that information to the W-Element Settings area for analysis.
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Prerequisites:

l Use the Stackup Layers pane to select a layer. The Selected Layer Name field displays
the currently selected layer.

l Use the Trace Cross Section button to open the HFSS Etch Factor window.
l Use the Frequency drop-down menu to select the frequency used for trace width
calculations.

To calculate trace width or pitch:

1. Select the Synthesis tab.
2. Select the Single Ended Nets or Differential Nets tab.
3. Use the drop-down menus to select the required impedance or differential impedance (in

ohms), as well as reference layers.
4. If you are using the Differential Nets tab, select either Fix trace width at or Fix trace

pitch at and enter a value.
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Important:

By default, Fix Trace Pitch is selected. Selecting Fix Trace Width changes the
calculator so that it computes pitch instead of width.

5. If you wish to define coplane wave reference planes, select Define CPW ref. planes (edge-
to-edge) to enable additional options.
l You may select Left plane spacing, Right plane spacing, or both.
l For W-element export, selecting Left plane spacingmeans that aggressors may only be
added to the right of a victim trace; any traces to the left are removed. Selecting Right
plane spacingmeans that aggressors may only be added to the left of a victim trace; any
traces to the right are removed.

6. To perform the calculation, click Compute width.
The green progress bar shows the calculation's progress.

When the calculation is complete, the Approx width area updates to show the calculated
result.

Using the Impedance Wizard 3-6

Ansys Electromagnetics Suite 2025 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



SI Xplorer Help

7. Use the slider above the progress bar to update trace width as well as the required Zdiff
value.
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To use a calculated width/pitch in w-element analysis:

l Click Use width/pitch in w-element:

W-element Analysis
W-elements are a distributed model for transmission lines used in certain HSPICE-compatible
circuit simulators. For designs containing traces and planes, SI Xplorer can export the W-
element in either single frequency or tabular format.

After you have used SI Xplorer's Impedance Wizard to calculate impedance, differential
impedance, or trace width/pitch, the Cross-section Visualizer area allows you to set up
aggressor traces around a victim trace and export the corresponding w-element.

To analyze and export the W-element:
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1. Click an element in the Cross-section visualizer or select it from the list in theW-Element
Settings area.

The following options are available:
l Add – Enter the number of aggressors to add, and use the drop-down menu to select
whether to add them on the right, left, or on both sides. Then click Add.
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Note:

If you previously enabled CPW settings during trace width, impedance, or
differential impedance calculation, your options will be limited.
l If you selected Left plane spacing, aggressors may only be added to the
right of a victim trace.

l If you selected Right plane spacing, aggressors may only be added to the
left of a victim trace.

l Delete Element – Click to remove an element.
l Single Frequency / Tabular Model – Select Single frequency and enter the frequency
in Hz, or select Tabular and click Set frequency range to set up a range of frequencies.

l W-Element Model Name – If appropriate, enter a new model name for the w-element.
l Export to 2D Extractor – generates a VB script to export the selected layer’s cross-
section to 2D Extractor. Microstrips, stripline and conformal coats are supported.
Generating this script launches a prompt asking if you want to run the script in
Electronics Desktop. Consult the Q3D Extractor/2D Extractor help for instructions on
running an analysis in 2D Extractor.

You can also double-click a value within theW-Element Settings list to change width and
pitch.

2. Make your appropriate selections, then click Export.
The Select Spice File to Export window appears.

Note:

If you selected Tabular W-element model but did not specify the frequency range,
the Frequency Sweep Dialog appears. You must specify the frequency range
before you can save.

3. Browse to a save location, name your file, and click Save.
The file is saved in Spice (*.sp) format.

Setting HFSS Etch Factor
HFSS geometry allows for the presence of an etch factor in the design and modeling of different
substrate layers. The specific etch factor that applies to a particular layer is usually available
from the manufacturer. But in general, the etch factor is calculated by taking the ratio of etch
depth to undercut.

Using the Impedance Wizard 3-10

Ansys Electromagnetics Suite 2025 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



SI Xplorer Help

When using the Impedance Wizard to calculate impedance, differential impedance, or trace
width/pitch, change the HFSS Etch Factor settings.

Access these options by clicking the button next to Trace cross section. The button name
reflects the current shape of the cross section:

The HFSS Etch Factor window appears:

The HFSS Etch Factor window acts as a calculator. Update any value and the other values, as
well as the cross section diagram, will update accordingly.

When the calculator opens, it is populated with top and bottom dimensions that correspond to
the default etch factor. These dimension values are representational and do not correspond to a
particular geometry in the layout.
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The Etch Factor value may be entered as a number or may be parameterized as a project
variable. If the input is a number, the calculator controls are available; otherwise, the calculator
controls are disabled. The top and bottom dimensions can be changed directly using their edit
controls or they can be modified using the slider. The slider sets the value of one dimension to a
percentage of the other. As the top and bottom dimensions are changed, both the etch factor
and the layer drawing are modified to reflect the change.

When you clickOK, the etch factor is applied to the selected layer.
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4 - Configuring Padstacks
Padstacks describe the stacking structure of shapes associated with pads and vias. They
enable different shapes on different layers. You can easily create and edit padstacks across all
board types. Changes to the saved format and functionality are minimal, since the padstacks are
independent of the number of layers in the design.

Padstacks consist of:

l Drill information
l Plane layer information – used for calculating the heat and iso shapes used on plane layers.
l Inner layer information – used for assigning different shapes for used/unused component
pads.

The Padstack Editor displays in the same pane as Stackup Layers.

If that pane has been closed, select View > Toolbars and Docking Windows > Reset
Workspaces. Then, ensure the Padstack Editor tab is selected:

The Padstack Editor consists of the following areas:

l Search Parameters – allows you to search for a padstack by name.
l Padstack List – lists padstacks in the selected library or libraries.
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l Padstack Options – buttons at the bottom of the pane allow you to add, edit, clone, or
remove padstacks. You can also use them to access padstack settings.

Searching Padstacks
Use the Search Parameters area of the Padstack Editor to find specific padstacks.

To find a padstack:

1. Click the ellipses button (...) to select one or more libraries from the list at the right.

If appropriate, enable the Select all libraries check box to view padstacks in all available
libraries.

2. From the Name field, type a search query.
3. Click Search.

The list of padstacks scrolls to where the search is found, and highlights the first row
meeting the search criteria.

Modifying Padstacks
Use the buttons at the bottom of the Padstack Editor to add, edit, remove, or clone padstacks.
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Adding Padstacks

To add a padstack:

1. Click Add Padstack.
The Definition Name window appears.

2. Enter a name for the padstack.
3. ClickOK.

The Edit Padstack Definition window appears.
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4. Enter an appropriate settings for the new padstack and clickOK. See: Padstack Settings.
The new padstack appears in the Padstack Editor's list of padstacks.

Editing Padstacks

To edit an existing padstack:

1. Select a padstack from the list of padstacks.
2. Click Edit Padstack.

The Edit Padstack Definition window appears.
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3. Enter an appropriate settings and clickOK. See: Padstack Settings.

Cloning Padstacks

To clone one or more existing padstacks:

1. Select the padstack(s) from the list of padstacks.

To select more than one padstack, use Ctrl+click.
2. Click Clone Padstack(s).

For each padstack selected, the Edit Padstack Definition window appears.

3. If appropriate, update each padstack's settings.
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4. For each padstack, clickOK to confirm settings.

When you have verified the settings for all cloned padstacks, the list updates to include the
cloned padstacks.

Removing Padstacks

Important:

This action cannot be undone.

To remove one or more existing padstacks:

1. Select the padstack(s) from the list of padstacks.

To select more than one padstack, use Ctrl+click.
2. Click Remove Padstack(s).

An alert appears, warning you that there is no way to undo this action.

Note:

You cannot remove padstacks from the system library.

3. Click Yes to continue.
The padstack(s) are deleted.

Padstack Settings
The Edit Padstack Definition window allows you to change the settings for a new or existing
padstack.

For more information about adding and editing padstacks, see: Modifying Padstacks.

To access the Edit Padstack Definition window:

1. Select the Padstack Editor tab to view the Padstack Editor.
2. Select a padstack from the list of padstacks and perform one of the following actions:

l Right-click the padstack and select Edit Padstack, or
l Click the Edit Padstack button.
The Edit Padstack Definition window appears.
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This window contains the following areas for changing settings:

l General – allows you to set a padstack name, via material, and plating percentage.
l Hole – allows you to set a hole shape, dimensions, and range (depth). The dimensions
available for editing depend on the shape of the hole.

l Solderball – allows you to set a solderball shape, dimensions, material (default: solder),
and connection point (above or below the padstack). The dimensions available for editing
depend on the shape of the solderball.

l Backdrill – [[???]]
l Layers – a list of layers in the padstack. You can add or remove a layer using an appropriate
buttons, or change a layer's settings in the Layer Settings area below.

l Layer Settings – activated only when a layer is selected in the Layers list. See: Pad,
Antipad, Thermal Pad, and Connection Point below.
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Additionally, it displays the following visualizations:

l Cross Section View – displays all definition layers and their pads from a side view. Layers
selected in the Layers list are highlighted in red. Hovering the cursor over a layer displays
its name as a tooltip.

l Top View – displays the pads of selected layers from a top down perspective.

Pad Settings
Pad settings vary based on the shape of pad chosen.

Pad shape choices are:

l None – no pad.
l Circle – specify the diameter, offset x, and offset y.
l Square – specify the size, offset x, and offset y.
l Rectangle – specify the x size, y size, offset x, and offset y.
l Oval – specify the x size, y size, corner radius, offset x, and offset y.
l Bullet – specify the x size, y size, corner radius, offset x, and offset y.
l N-Sided Polygon – specify the size, number of sides, offset x, and offset y.
l Polygon – specify the shape, offset x, and offset y. See: Polygon Editor.

Antipad Settings
Antipad settings vary based on the shape of antipad chosen.

Antipad shape choices are:

l None – no antipad.
l Circle – specify the diameter, offset x, and offset y.
l Square – specify the size, offset x, and offset y.
l Rectangle – specify the x size, y size, offset x, and offset y.
l Oval – specify the x size, y size, corner radius, offset x, and offset y.
l Bullet – specify the x size, y size, corner radius, offset x, and offset y.
l N-Sided Polygon – specify the size, number of sides, offset x, and offset y.
l Polygon – specify the shape, offset x, and offset y. See: Polygon Editor.

Thermal Pad Settings
Thermal pad settings vary based on the shape of thermal pad chosen.

Thermal pad shape choices are:

Configuring Padstacks 4-8

Ansys Electromagnetics Suite 2025 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



SI Xplorer Help

l None – no thermal pad.
l Polygon – specify the shape, offset x, and offset y. See: Polygon Editor.
l Round45 – specify the inner size, channel width, isolation gap, offset x, and offset y.
l Round90 – specify the inner size, channel width, isolation gap, offset x, and offset y.
l Square45 – specify the inner size, channel width, isolation gap, offset x, and offset y.
l Square90 – specify the inner size, channel width, isolation gap, offset x, and offset y.

Connection Point Settings
For the Connection Point, select a Direction.

l None – No direction.
l Any – specify x and y, for any direction.
l [# in Degrees] – specify x and y.

Polygon Editor
The Polygon Editor appears when you specify that a pad, antipad, or thermal pad is polygonal
in shape.

The window is divided into two sections:
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l Polygon Points – lists the points of the polygon. Right-click in this area to add points, then
edit the values in the X and Y columns.

l Polygon Preview – displays a preview image of the polygon. Right-click in this area to
zoom in, zoom out, fit the polygon to the view window, or change the display attributes.
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5 - Using the Via Wizard
Traces are separate conducting lines that make up an important part of the PCB layout.

Vias consist of a hole cut in the PCB to route a trace vertically from one layer to another, as well
as the vertical pieces of conductor that make connections between layers. If a via is too big, it
does not have sufficient room to route signal traces. If vias are made smaller, more traces can be
drawn.

The Via Wizard pane allows you to configure and visualize via breakouts.

The Via Wizard's visualization can be either solid or wireframe. To toggle between these views,
select View > View Design in Fill Mode.
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The process for using Via Wizard generally follows these steps:

l Configure padstacks
l Configure vias and visualize via breakouts
l Add backdrills, if appropriate
l Set the design up for HFSS simulation, if appropriate
l Post-process results in Network Data Explorer

Configuring Vias
Traces are separate conducting lines that make up an important part of the PCB layout.

Vias consist of a hole cut in the PCB to route a trace vertically from one layer to another, as well
as the vertical pieces of conductor that make connections between layers. If a via is too big, it
does not have sufficient room to route signal traces. If vias are made smaller, more traces can be
drawn.

Launch the Configure Via window in Via Wizard one of the following ways:

l Select Project > Configure Via.
l From the Via Wizard pane, click Insert Config.
l From the Via Wizard pane, edit an existing via configuration by clicking the Edit button.
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The Configure Via window appears.

Specify the settings as appropriate:

l Name – enter a name for the via.
l Padstack – select a padstack from the list. New stacks can be added from the Padstack
Editor.

l Ground Via – select a ground via from the list.
l X Loc – enter a value and unit.
l Y Loc – enter a value and unit.
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l Via Pitch – specify the distance between two adjacent vias. A smaller via pitch introduces
more mutual coupling capacitance.

Note:

The Via Pitch setting is only available when Is Differential Pair is selected.

l Ports – determine whether to insert ports at the input trace, output trace, both traces, or
neither.

From the Trace Configuration area:

l Specify the width and length for both input and output traces.
l If applicable, specify the pitch and transition length for input and output traces.

Note:

Pitch and Transition Length options are only available when Is Differential Pair
is selected.

l If applicable, use the check boxes to:
l Specify a differential pair.
l Select Auto Generate Extents. This is used to automatically compute the reference
plane extents based on the length of traces above or below the said planes.

l Use the width/pitch calculated in ImpedanceWizard. See: Calculating TraceWidth
and Pitch.

From the Stitching Via Definition area:

l Add Stitching Via – opens a dialog box that allows you to specify the radius and angle for a
new stitching via. If you need to remote a stitching via, select it from the list and click Delete
Stitching Via.

Click Insert Config to insert the configuration for use in Via Wizard.

Adding Backdrills
Unused portions of vias (known as "stubs") can create significant signal integrity disturbances.
Backdrilling is a technique that removes these stubs.

To add a backdrill in SI Xplorer:

1. Insert a via configuration.
2. From the Via Wizard, click a port or padstack in the diagram to select it.
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3. Click Edit PS Instance.
The Padstack Usage and Definition window appears.

4. Use the options in the Backdrill area to define a backdrill:
l Top – use the drop-down menu to select the depth of the backdrill from the top layer.
l Bottom – use the drop-down menu to select the depth of the backdrill from the bottom
layer.

l Diameter – for either top or bottom, specify the backdrill's diameter.
The Cross Section View and Top View areas update to display the backdrill.
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5. ClickOK.
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6 - Running Simulations
Performing a simulation in SI Xplorer involves the following steps:

1. Edit Design Settings for Simulation.
2. Add an HFSS Solution Setup.
3. Run a Validation Check.
4. Click Simulation > Analyze.

The Progress Monitor displays simulation progress.

TheMessage Manager alerts you of important developments, such as errors.

Editing Design Settings for Simulation
Before running a simulation, you may want to adjust the design settings:

l Click Simulation > Design Settings.

The Design Settings window appears. It consists of six tabs:

l DC Extrapolation
l Nexxim Options
l Export S Parameters
l Design Mode
l Lossy Dielectrics
l HFSS Meshing Method
l HFSS Adaptive Mesh

Adjust the settings as appropriate and clickOK to apply. On any tab, you may select Save as
default to preserve your settings on that tab as the default.

The sections below describe the available settings in greater detail.
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DC Extrapolation Settings

The DC Extrapolation tab allows you to select one of Standard DC Extrapolation or
Advanced DC Extrapolation.

Important:

This setting changes the "ground rules" of the modeler and may have unexpected
results.
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Nexxim Options

The Nexxim Options tab allows you to select:

l Whether to Use circuit S-parameter definition (conjugate match for port impedances)
l Method used to transform time to spectral domain (FFT, Fourier Integration, or Fourier
Transform)
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Export S Parameters Settings

The Export S Parameters tab allows you to:

l Set/View Export Preferences – opens the SYZ Data Export Options window, from which
you can export Touchstone or Broadband.

l Export touchstone file after completing frequency sweep – selectOverride and use
the asterisk (...) button to select a destination other than the default.
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Design Mode

The Design Mode tab allows you to selectGeneral or IC (i.e., Integrated Circuit) mode.
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Lossy Dielectrics Settings

The Lossy Dielectrics tab allows you to Automatically use causal materials. This causes
objects with constant material permittivity greater than one and dielectric loss tangent greater
than zero to be treated as frequency dependent. Their actual permittivity and conductivity will be
determined by the Djordjevic-Sarkar algorithm, and the loss tangent will be zero.
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HFSS Meshing Method Settings

The HFSS Meshing Method tab allows you to select one of three meshes:

l Phi Mesh
l Phi Plus
l Classic Mesh

Additionally, you can select:

l Use alternative mesh methods as fallback
l Enable Design-level intersection checks

Consult the HFSS help for additional information about HFSS meshing.
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HFSS Adaptive Mesh Settings

The HFSS Adaptive Mesh tab allows you to adjust settings for:

l Maximum Number of Frequencies for Broadband Adapt:
l Auto – select this radio button to have the maximum number automatically defined.
l Specify – select this radio button and enter a value for the maximum number of
frequencies.

l Save Adaptive Mesh Control Files – this option is disabled by default to preserve disk
space.

SYZ Data Export Options
To export S parameter data in either Touchstone or Broadband format:

1. From the Design Settings window, select the Export S Parameter tab.
The Export S Parameter tab appears.
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2. Click Set/View Export Preferences.
The SYZ Data Export Options window appears.

Running Simulations 6-9

Ansys Electromagnetics Suite 2025 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



SI Xplorer Help

3. Select either Export Touchstone or Export Broadband.
The availableOutput Options and Export Options vary based on your selection.

4. Click Save As Default to save your settings, or click Cancel to exit.
You are returned to the Design Settings window.

5. If appropriate, selectOverride and specify a file destination other than the default.
6. ClickOK to exit the window.
7. Run a simulation.

When it completes, the exported file appears in the destination you specified (or the default).

Adding an HFSS Solution Setup
There are two ways to add an HFSS solution setup:

l HFSS Auto Setup
l HFSS Advanced Setup

Important:

In addition its own settings, SI Xplorer respects any HPC and Analysis Options
selected for the HFSS 3D Layout design type in Ansys Electronics Desktop.

HFSS Auto Setup
To add an HFSS Auto solution setup:

1. Click Simulation > Add HFSS Solution Setup > Auto.

Auto setup features a simplified window with a slider bar that you can adjust from Higher Speed
(which sacrifices accuracy to achieve optimum speed) to Balanced (which is more accurate but
faster than the highest accuracy setting) to Higher Accuracy (which takes the time to ensure
optimal accuracy).
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The auto setup includes a single sweep, for which you can edit the Distribution, Start, and End.
The design must include one or more ports.

Use the Sweep Type drop-down menu to select either:

l Discrete – generates field solutions at specific frequency points in a frequency range.
l Interpolating – estimates a solution for an entire frequency range using an adaptive rational
function interpolation method. Using an Interpolating Fast sweep will result in faster
analysis, however the current distribution values cannot be saved.
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When Use Q3D to solve DC point is selected, the HFSS solver invokes Q3D Extractor to
explicitly solve for a DC point. The mesh from HFSS is used for the Q3D extraction, with sources
and sinks defined based on HFSS port assignment. Matrix reductions are automated to
integrate the Q3D results with HFSS.

Use the Frequency Sweeps area to specify sweeps in terms of Distribution type, which can
be:

l Linear Step
l Linear Count
l Log Scale
l Single Point
l Single Point Sweep, which adds a set of 10 Single Point Sweeps defaulting from 1 GHz to
10 GHz in increments.

To add more sweeps (including mixed sweep types), use the Add Above and Add Below
buttons. This feature provides flexibility (e.g., you can define sweeps with log scale at lower
frequencies and linear step at higher frequencies).

If appropriate, use the Defaults tab to save your settings as the default or revert to the original
settings.

HFSS Advanced Setup
To add an HFSS Advanced solution setup:

1. Click Simulation > Add HFSS Solution Setup > Advanced.

The settings for Advanced setup are divided into eight tabs:
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l General – general solution settings.
l Options – settings for lambda refinement, adaptive analysis and solution, order of basis,
and whether to enable the use of solver domains.

l Advanced – settings for defeaturing a mesh, which model type to use, and vias.
l Advanced Meshing – settings for curve approximations and layer alignment.
l Solver – port settings and configurations for modeling.
l DC R – settings for the DC Resistance and Inductance analysis.
l Defaults – enables you to save the current settings as the defaults for future solution setups
or revert the current settings to HFSS's standard settings.
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HFSS Advanced Setup – General Tab

TheGeneral tab allows you to set the following:

l Setup Name – Name of the setup. It must be unique.
l Enabled – If not enabled, this setup cannot be analyzed and will be not included in a general
“Analyze” of all setups.
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l Solution Frequency – Specify the frequency and units at which to generate the solution. If
a frequency sweep is solved, an adaptive analysis is performed only at the solution
frequency. The following fields change according to your selection:
l Frequency – The adaptive frequency for refinement.
l Low Frequency – The smallest adaptive frequency for refinement for a Broadband.
l High Frequency – The largest adaptive frequency for refinement for a Broadband.
l Maximum Number of Passes – The maximum number of mesh refinement cycles that
you would like HFSS to perform. This value is a stopping criterion for the adaptive
solution. If the maximum number of passes has been completed, the adaptive analysis
stops. If the maximum number of passes has not been completed, the adaptive analysis
continues until the convergence criteria are reached.

l Maximum Delta S – The magnitude of the change of the S-parameters between two
consecutive adaptive passes. This is a stopping criterion for the adaptive solution. If the
magnitude of the change of all S-parameters are less than this value from one iteration to
the next, the adaptive analysis stops. Otherwise, it continues until the requested number
of passes is completed.

l Output Var. – A button labeled Add to add output variables to the refinement criteria for
that frequency or Edit to edit the output variables for that refinement criteria. Selecting
this option brings up the Advanced Mesh Convergence dialog box or displays the error
message 'You must have at least one output variable defined' if you have no output
variables defined in your design. Users may receive the error 'You must have at least one
output variable defined that returns a single real value (as opposed to complex, etc)'.
l Output Variable – The name of the output variable.
l Include – A check box for whether to include the value of this output variable in the
mesh convergence calculations.

l Max Delta – The maximum amount of change appropriate in the output variable
between adaptive passes. It is a stopping criterion for the adaptive solution. If the
output variable changes from one iteration to the next by an amount that is less than
Max Delta, the adaptive solution.

l Add – Adds a new frequency to the table.
l Remove – Removes a selected frequency from the table.

l Fields – Click Save fields to post process or plot fields. This is only available for Discrete
Sweep Types. To restrict the fields saved to radiated fields, click Save radiated fields only.

l Use Defaults – The target defaults depend on the Order of Basis function selections (e.g.,
for Driven solutions and a First Order basis function, the default target is 0.3333. HFSS
refines the mesh until most element lengths are approximately one-third wavelength).
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HFSS Advanced Setup – Options Tab

TheOptions tab allows you to set the following:

l Initial Mesh Options:
l Do Lambda Refinement – Lambda refinement is the process of refining the initial mesh
based on the material-dependent wavelength.

l Lambda Target – The fraction of the wavelength that determines the refined tetrahedra
edge length (e.g., if the value is 0.1 then a edge length of 0.1 is used as the refinement
target).

l Use Defaults – The target defaults depend on the Order of Basis function selections
(e.g., for Driven solutions and a First Order basis function, the default target is 0.3333;
HFSS refines the mesh until most element lengths are approximately one-third
wavelength.).

l Adaptive Options:
l Maximum Refinement Per Pass – determines how many tetrahedra are added at each
iteration of the adaptive refinement process. The tetrahedra with the highest error is
refined. The value is a percentage.
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l Maximum Refinement – The maximum number of tetrahedra that can be added during
an adaptive pass. By default, this unchecked, to that there is no maximum. If you enable
the Maximum Refinement, the initial value is 1000000.

l Minimum Number of Passes – The maximum number of mesh refinement cycles that
you would like HFSS to perform. This value is a stopping criterion for the adaptive
solution. If the maximum number of passes has been completed, the adaptive analysis
stops. If the maximum number of passes has not been completed, the adaptive analysis
continues unless the convergence criteria are reached.

l Minimum Converged Passes – An adaptive analysis does not stop unless the minimum
number of converged passes has been completed. The convergence criteria must be met
for at least this number of passes before the adaptive analysis stops.

l Solution Options:
l Order of Basis Functions – The order of the basis functions HFSS uses to interpolate
field values from nodal values. The Zero order option is useful when a model requires a
mesh that produces more than 100,000 tetrahedra, but the model size is small compared
to wavelength. The higher order options solve progressively more unknowns for each
tetrahedra. Mixed order uses higher order where more accuracy is required, and lower
order where fields are weaker.

l Enable Iterative Solver – The iterative solver provides an alternative to the multi-frontal
solver when a matrix is well-conditioned for an iterative solution. The iterative solver
significantly reduces memory usage, and it can also provide a savings in the solution time
for large simulations. When this option is enabled, HFSS automatically invokes the
iterative solver when it decides that the matrix is conditioned well enough to take
advantage of the iterative approach. HFSS uses the multi-frontal solver if the matrix does
not meet this requirement.

l Relative Residual – The residual measures the convergence of the iterative solver. The
default value is 1E-4.

l Enhanced low frequency accuracy –When enabled, the solver is tuned to reliably
solve low frequencies for designs that only contain lumped ports as sources or a
combination of lumped and circuit ports. In addition, for designs with only lumped ports
and/or circuit ports, interpolating sweeps are tuned to solve more low frequency points in
order to accurately represent very low frequency results.

Note:

This requires more RAM in order to solve the entire solution vector for
interpolation sweeps and for discrete sweeps not saving fields.
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HFSS Advanced Setup – Advanced Tab

Use the Advanced tab to set the following:

l Defeaturing Options:
l Form polygon unions before meshing – specifies whether all objects are combined or
“unioned” before meshing takes place. This can simplify the mesh; it can, however, also
remove internal boundaries that may be desirable. “Unioning” is a complex operation and
sensitive to almost coincident edges; in some instances, a union may produce
undesirable results. Inspecting the mesh is a simple way to verify the operation.
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l Remove voids with an area smaller than <value> – simplifies meshing by removing
small voids.

l Remove Floating/Inactive Signal Net Geometry – approximates a mesh by removing
inactive geometry.

l Model Type Options:
l General – this model offers standard mesh processing.

l Use polygon defeaturing – removes very close points, points that do not contribute to
the geometry of an edge (e.g., collinear), and very thin intrusions. When used with
"unioning", it can be helpful in healing geometry that is not snapped together.
l Tolerance as a ratio of the data exent – tolerance value specified as a ratio of the
overall data extent. This value must be very small.

l Absolute distance – tolerance specified as an absolute value (e.g., 0.0001mm).

Note:

From the Vias area, vias may be modeled as a simple 'wirebond' or as a 3D
ribbon or solid. The values specified in the analysis setup only apply to vias
that do not have specific property overrides; all properties explicitly specified
for a via take precedence over these values.

l Point -to-edge and point-to-point snapping – snaps points to edges and points to
points if they are within a minimum dimensional tolerance. This tolerance is based on
geometry extents.

l IC [Beta] – this model type optimizes mesh processing to simulate on-chip structures.
l Vias Options:

l Mesh as a 3D via – vias are modeled using rectangles to form a 3D ribbon or solid.
l Number of sides – number of sides to use when creating the 3D representation. If
less than 3, the via is modeled as a flat ribbon.

l Via Field – this option is disabled in SI Xplorer.
l Via material default – when a material has not been specified in the padstack definition
and there is no override in the properties for a via, then this is the material associated with
the via mesh. It is initially set to copper.
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HFSS Advanced Setup – Advanced Meshing Tab

Use the Advanced Meshing tab to set the following:

l Circle and arc approximation – circles and arcs must be replaced with straight edge
approximations before meshing. There is no attempt to match areas. Points are simply
introduced on the original arc at the locations specified by the following parameters.
l Arc setup size – the angular interval below which mesh points are added.
l Starting azimuth for circles – specifies the location of the first mesh point or circles.
l Maximum number of arc points – the maximum number of mesh points on a given arc
segment.

l Use arc to chord error approximation technique for arc – the resulting straight edge
approximation will not deviate from the original arc by more than the specified error.
l Maximum arc to chord error – maximum distance permissible between a straight
edge approximation (the chord) and the original arc.

l Hierarchical Layer Alignment – aligns layers across hierarchical boundaries.
l Snap tolerance –When layers across hierarchical boundaries are within this unitless
tolerance, they are aligned to the same elevation. This value represents a fraction of total
stackup height.
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HFSS Advanced Setup – Solver Tab

Use the Solver tab to set the following:

l Port Options:
l Maximum Delta Zo – specify Zo as a target percentage. The default is 2%.
l Set Triangles for Wave Port – controls the number of triangles used for a wave port. For
designs with lumped ports, this option is not active. Higher numbers of triangles would not
benefit a solution setup in this case. Set values for theMin andMax number of triangles.

l Modeling Options:
l Signal layers thinner than <value> are modeled as zero thickness – Negative signal
layers in the design which are thinner than the given value are modeled as being infinitely
thin in order to reduce simulation time.

l Dielectrics thinner than <value> are merged with an adjacent – Dielectric layers in
the design which are thinner than the given value are merged into an adjacent dielectric.
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Material properties are accumulated using a weighted average.
l Enable intra-plane coupling of Pwr/Gnd nets for enhanced accuracy

HFSS Advanced Setup – DC R Tab

Use the DC R tab to set the following:

l Maximum Number of Passes
l Minimum Number of Passes
l Minimum Converged Passes
l Percent Error
l Percent Refinement Per Pass

Running Simulations 6-22

Ansys Electromagnetics Suite 2025 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



SI Xplorer Help

HFSS Advanced Setup – Defaults Tab

Use the Defaults tab to save your settings as the default or revert to the original settings.

Running a Validation Check
To run a validation check:

1. Click Simulation > Validation check.
A progress bar displays the validation check progress. When the check has completed, the
number of Errors and Warnings display:
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A green check mark appears next to items that have passed validation. A red X appears
next to items that have failed validation.

Additional details may be available in theMessage Manager.
2. Click Close to exit.

Running Simulations 6-24

Ansys Electromagnetics Suite 2025 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



SI Xplorer Help

7 - Network Data Explorer
Network Data Explorer provides visualization, analysis, and manipulation tools for network
data.

To access Network Data Explorer, click the Network Data Explorer tab in the Plots and
Messages window:

Network Data Explorer Overview
The Network Data Explorer window is divided into the following panes:

1. Network Data Explorer Ribbon – allows you to perform Network Data Explorer's
functions.

2. Data Selection Pane – allows you to select a network data file.
3. Cell and Frequency Selection Pane – allows you to narrow your selection.
4. Data View Pane – displays data in table or plot format.

The panes are shown in the following figure. Additional information about each pane follows.
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Network Data Explorer Ribbon

From the ribbon, you can control:

l Plotting – determine how the data is displayed. Click the Sweep orMatrix icon to select a
plot type.

l Quantity – select the type of quantity to display (parameter values, matrix statistics, or
causality plots).

l Parameter Type – choose parameters for display (S, Y, or Z parameters, Port Impedance,
or Gamma).

l Format – decide the display function to apply to the data (e.g., magnitude, phase, dB, real,
or imaginary).

l Export – export either SYZ data (*.s1p, *.ts, *.nmf, *.tab, *.m, *.cit) or Broadband data (*.sp).
l Causality Checking – check causality.
l Cores – enable or disable multithreading.
l Post-Processing – choose between terminal data and differential pairs, if your design
includes differential pairs.

See: Network Data Explorer Ribbon.
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Data Selection Pane

This pane allows you to view and compare various data sets. Original data sets appear under
Files. Click one of these to see the data set as it was when it was opened. Altered data sets
(data sets that have been smoothed, transformed, or changed in some way) are listed under
Edited.

Cell and Frequency Selection Pane

This pane allows you to choose to choose which cells or frequencies to display.

To select all frequencies or cell entries, use the Select All check box on the ribbon.
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This pane can also list available variations. Selecting a variation activates it and affects table,
plot, and statistics displays. When displayed by frequency, the entire matrix is presented in the
Data View pane for each selected frequency. When displayed by matrix cell, the data for the
individually chosen cells is shown across all frequencies. Use the Select All check box to select
all variations.

Warning:

Given the volume of data in many network data sets, choosing Select Allmay take a
considerable time to generate, especially in Plot view.

Data View Pane

The Data View Pane displays either table or plot data, depending on your selections.

Loading Data into Network Data Explorer
You can launch Network Data Explorer from within several Ansys products. From the Project
Manager, open <project> > Analysis > Setupn > Sweepn. Right click on the sweep and click
Network Data Explorer in the shortcut menu. The current solution data is automatically loaded
and ready for viewing. Otherwise, you must load a data file into Network Data Explorer.
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Note:When solution data that is loaded into NDE is modified and resimulated in
another Ansys product, the NDE data automatically updates.

You can import the following file types:

l Touchstone Format (*.s*p)
l Touchstone 2 Format (*.ts, *.sp)
l Citifile (*.cit)
l Neutral Format (*.nmf)
l State Space File (*.sss)

Note:

When this type of file is loaded, Network Data Explorer regenerates s-parameter
data based on the file.

You can compare the regenerated s-parameters to the original data.

To import a file into Network Data Explorer, either drag and drop an analysis from the Project
Manager into Network Data Explorer or

1. On the NDE ribbon, clickOpen. AnOpen window opens.
2. Navigate to and select a file.
3. ClickOpen. The file appears in the Files tree.

The file browser allows you to open multiple files at a time. However, the displayed data always
corresponds to the data set indicated in the Network Data Selection pane. Click the file you want
in that pane to switch between data sets.

Exporting Data from Network Data Explorer
Network Data Explorer allows you to export data to a variety of different file formats.

In this section, you will learn about:

Exporting SYZ Data

Exporting Macro Model

Creating an NPort Model
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Exporting SYZ Data

To export SYZ data from within Network Data Explorer, click the Save As icon on the NDE
ribbon. The Save File As window appears.

You can export data in any of six file types:

l Touchstone Format 1.0 (*.s*p)
l Touchstone 2 Format (*.ts)
l Neutral Format (*.nmf)
l Data Table Spreadsheet (*.tab)
l MATLAB (*.m)
l Citifile (*.cit)

Select a file type and name for export. A Specify Export Options window appears.
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Depending on the type of export file, different options appear. However, all file types allow you
to:

l Select from S Matrix, Y Matrix, and Z Matrix data.
l Select the Display Format.

Some types allow you to create an NPort Model in the active project.

Exporting Macro Model
Network Data Explorer lets you export macro model data. To export data, click the Broadband
icon on the NDE ribbon.

The Broadband Export Options window appears.
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Click Advanced to view all options.
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Macromodel Output Options include:

l Output File – Allows you to choose the name and location of the file.
l Subcircuit Name – Use this field to name the subcircuit.
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l Change Output File Format – Check this box to open a submenu allowing you to select a
new output format.

l Use Common Ground – Check this box to use common ground. When this option is on,
ports are referenced to ideal ground (node 0). When this option is off, extra ports are
generated to provide the reference levels. Common grounding is ideal when the pins are
physically near to each other and ideal ground is suitable. For distant connections and
circuits with non-ideal reference levels such as differential pairs, common grounding is not
used.

Note:
o R and L values may be quite sensitive to the values of the S-parameters. This is
an issue if the actual impedance value is much greater than or much less than
the reference impedance of the S-parameters.

o Since resistances of power cables is typically in the milliohms range at DC,
using a reference impedance of 50 ohms is 5000 times higher. This causes any
fitting errors in the state space model to get multiplied by 5000 times when the R
and L values are computed.

o As a general rule, for high power applications a reference impedance of 1 ohm is
probably a better choice than 50 ohms.

Macromodel Generator Options include:

l Enforce Model Passivity – Check this box to enforce passivity.
l Ensure Accurate Z-fit – Check this box when state-space fitting of Y-parameters or Z-
parameters does not produce an accurate fit.

l appropriate Fitting Error – Allows you to select the value at which rational fitting fails (if the
fitting error exceeds this value).

l Renormalize – Check this box to renormalize using the specified impedance item. 50 ohms
is the default setting, but you can type a different value.

Note:
o R and L values may be sensitive to S-parameter values. This presents an issue
if the actual impedance value is much greater than or much less than the
reference impedance of the S-parameters.

o Since resistances of power cables are typically in the milliohms range at DC,
using a reference impedance of 50 ohms is 5000 times higher. This causes any
fitting errors in the state space model to be multiplied by 5000 when the R and L
values are computed.

o For high-power applications, a reference impedance of 1 ohm is generally a
better choice than 50 ohms.
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Miscellaneous Options include:

l Compare Fit –When this box is checked, the original and derived solution will be available
for comparison. You can click Edit Description to open the Derived Solution Description
window and add a text description to better identify the export.

Advanced Options include:

l Maximum Order – Allows you to specify the number of poles. See Note below.
l Passivity Options – If you enabled Enforce Model Passivity, this area allows you to
select the passivity enforcement method.
l Convex optimization algorithm – guarantees a passive state-space realization, but is
very slow and memory-intensive. Not practical for numbers of ports beyond ten.

l Passivity-by-perturbation algorithm – designed for systems with a large number of
ports. Less accurate than the Convex optimization method.

l Iterated fitting of passivity violations (IFPV) (default) – less accurate than other
algorithms but more suitable for larger numbers of ports.

l Iterated fitting of PV (low frequency) – similar to IFPV while improving the fit to “Z” at
DC and low frequencies. A better choice of passivity enforcement when the fit to
corresponding “Z-data” is important such as power delivery, EMI/EMC applications.

Note:

For a more detailed explanation on any of the passivity options, consult the
Circuit help.

l Column Fitting Options – This area allows you to choose how poles are matched to
columns:
o One Column at a Time – The set of poles will be shared across all entries of a single
column.

o One Entry at a Time – Each entry will be fitted using a separate set of poles.
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o Entire Matrix – The set of poles will be shared across all entries of the matrix being fitted.

Note:
n Typically, using the same set for all entries is adequate, and yields the most

compact models. However, if all the entries of the matrix have completely
unrelated transfer functions, it may be better to fit them using separate pole
sets.

n The optionsOne column at a time andOne entry at a time do not work
when either Ensure accurate Z-fit or FastFit is used.

l State Space Fitting Algorithm – Allows you to select FastFit, TWA, Iterated rational fitting.
o FastFit (default) – FastFit is the ANSYS-proprietary method for state-space fitting.
Network Data Explorer uses FastFit for calculating the state-space matrices from the
network data. The FastFit algorithm for state-space fitting is an alternative to the Tsuk-
White algorithm (TWA) and Iterated Rational Fitting (IRF) methods. FastFit is generally as
accurate as TWA, but is significantly faster than both TWA and IRF. It also aims to fit the
lower frequencies with higher fidelity.

o TWA – The Tsuk-White Algorithm is an ANSYS-proprietary method for fitting a state
space model to extracted s-parameter data. It uses techniques based on Singular Value
Decomposition (SVD) to quickly determine required number of poles for fitting a model.

o Iterated Rational Function – The IRF fitting approach takes a matrix of S-parameter
data and, for each matrix entry, tries a succession of different pole-zero approximations
(increasing the number of poles used at each iteration) until it can find an acceptable fit to
the data. For broad frequency sweeps and large numbers of excitations, this process can
be time consuming because of all the iterations and is not guaranteed to produce a good
fit to the data. It is retained as a fallback if the TWA algorithm fails.

l Enable Relative Error Tolerance – Allows you to enable relative error tolerance, which
works best with TWA fitting.

Note:

The Enable Relative Error Tolerance option works best with the TWA fitting
algorithm, is not recommended for use with iterated rational fitting, and is disabled
when either FastFit or Ensure accurate Z-fit is used.

l Enforce Causality – Allows you to make non-causal data causal. Use this option only if
fitting fails without it.

Network Data Explorer 7-13

Ansys Electromagnetics Suite 2025 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



SI Xplorer Help

Note:

Broadband models are built from a rational-function approximation of the data. The
fidelity of this approximation can be controlled by setting the Maximum order
(number of poles).

ClickOK to begin the export. TheMessages pane details the export process.

Comparing Original S-Parameters with Exported S-Parameters

If Compare Fit was checked during export, the Data Selection pane updates to list both the
original and exported solution and the Compare checkbox is checked.

Network Data Explorer Ribbon Actions
The Network Data Explorer ribbon provides access to many of Network Data Explorer's
functions.

In this section, you will learn about:

Setting Display Format

Displaying Full Port Names

Saving or Restoring Default Settings

Smoothing All Frequencies

Cell Filtering

Editing Port Properties

Defining Differential Pairs and Displaying Mixed Mode Parameters

Network Data Explorer – Setting Display Format
The Display Format window affords additional control over the display of values in Network
Data Explorer.
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To access this window from the ribbon, click Display Format ( ).

The Display Format window appears.

The Number Format options allow you to specify Field Width (the minimum number of
characters used to display a number) and Precision (the number of decimals to display). You
can also check the Use scientific notation check box, if appropriate.

The Data Comparisons options allow you to choose Post-format difference or Pre-format
difference.

l Post-format difference – when comparing datasets, subtract values after applying the
formatting function (dB, magnitude, etc.); the values displayed will be the difference
between the magnitude, dB, and so on.

l Pre-format difference – when comparing datasets, subtract values before applying the
formatting function (dB, magnitude, etc.); the values displayed will be the magnitude, dB,
etc., of the complex difference.

The Units option allows you to specify the Length unit (the unit used to display and interpret
length values). The default is mm.
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Network Data Explorer – Displaying Full Port Names
By default, port names in Network Data Explorer are displayed in an abbreviated form: P1, P2,
etc. This applies to both the Data Selection pane and the Data View pane.

To change this so that full port names are displayed, select Show Port Names on the ribbon:

The following figure shows the difference in display for a plot.
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Note:

Tool-tips always display the full port name.

Network Data Explorer – Saving or Restoring Default Settings
To save field settings as the default, click Save Settings. The next time Network Data Explorer
is opened, the chosen settings will be selected by default.

To restore the original defaults, click Restore Settings. The next time Network Data Explorer is
opened, the original settings will be selected by default.

Smoothing
To access data smoothing options:

1. Click the Smoothing icon on the NDE ribbon.

The Smoothing window appears.

2. The Smoothing Parameters area allows you to choose the Expansion Order. This can be
any discrete value between 1 and 150.

3. If appropriate, check the Enforce Causality check box.
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4. If appropriate, check the Create a new data set containing the smoothed data check
box. If selected, the smoothed data appears alongside the original data.

5. ClickOK.

The Data View Pane updates. The following image shows a plotted result with Create a new
data set containing the smoothed data unchecked and checked.

A least-squares polynomial fit of the specified order is used to interpolate new data points for the
magnitude and phase components of the S-parameters.

Cell Filtering
The cells available in the data selection pane may be restricted using cell filtering. The Cell
Filtering control are located on the NDE ribbon.

Cell filtering is modeless, and filters are immediately applied to the cell list. Filtering remains in
effect when the window has been closed.

For an n-port model with a total of 2n pins in the standard arrangement, the choices are:

l Show all – display all available cells. There are n-squared choices.
l Return loss – show S(i, i). There are n choices.
l Insertion loss – show S(i, i+1). There are n choices.
l Lower triangle – show S(i, j) for all j < i. There are n(n-1)/2 choices.

Three pin arrangements are recognized:
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l S(i, i+1) and its Reverse order, S(i, i-1)
l S(i, i+n) and its Reverse order, S(i, i-n)
l S(i, 2*n-i+1) and its Reverse order, S(i, 2*n-i-1)

Changing Port Properties and Reducing Matrix Size
The normalization impedance, termination, port order, gamma values, and de-embedding
distance may all be edited from the Port Properties window.

To access these options, click Edit Ports on the NDE tab. The Ports Properties
window opens.

Note: For HFSS Driven Terminal designs, selecting the solution data will disable this
ribbon button. Users must make port/differential pair changes directly in the HFSS
Design and re-import the solution.

Ports appear in a table. Click a column heading to sort by that column. Click within a cell to edit
the port property:

l Zo (ohm) and ZL (ohm) – specify Impedance values. Accepted syntaxes are:
l real (e.g., 50)
l real + imag i (e.g., 50+5i)
l imag i (e.g., 5i).

l Terminated – use the check box to terminate a port. Terminated ports are eliminated from
the matrix, reducing the matrix size. Existing data sets with mismatching port numbers will
no longer be available for data comparisons.

l De-Embedding – this column appears only if gamma values are available. Default units can
be changed from the Set Display Format window.

To reorder ports, click and drag a row to a new location.

To save changes, clickOK.
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Displaying Mixed-Mode Parameters using Differential Pairs
Network Data Explorer displays mixed-mode parameters when differential pairs are both defined
and activated.

To define differential pairs:

1. Select existing ports.
2. Open Network Data Explorer (Tools > Network Data Explorer).
3. On the NDE ribbon, select Differential Pairs.

The Differential Pairs window appears.

4. Select a pair from the list on the left and click Add Pairs.
5. ClickOK.
6. To disable all differential pairs, click the Enabled column header in the Differential Pairs

dialog to deselect all pairs.

For HFSS Driven Terminal designs, selecting the solution data will disable this ribbon button.
Users must make port/differential pair changes directly in the HFSS Design and re-import the
solution. When the HFSS Driven Terminal Design has differential pairs defined, NDE shows this
drop down menu and you can change between showing reports for Terminals or Differential
Pairs.Select Differential Pairs from the Post-process selection field to view mixed-mode
parameters.
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Note:

The Network Data Explorer Editmenu option Reset All Port Properties deactivates
all pairs, but it does not clear the differential pair settings. And since Reset All Port
Properties also clears reference impedances and terminations, it should not be used
when users want to disable all differential pairs.

Data View Pane Context Menus
The Data View pane presents different right-click menu options, depending on the context.
Some commands are the same as those on the NDE ribbon. Others appear only in the context
menus.

Network Data Explorer commands unique to the context menus are:

l Multiple Frequency Statistics
l Highlight Min/Max
l Select Transpose
l Color Legend Attributes
l Matrix Entries Plot Menu

Multiple Frequency Statistics
TheMultiple Frequency Statisticsmenu option determines the statistical composite to display
when multiple frequencies have been selected for the matrix display. The statistical data is
always the first matrix displayed, followed by matrices for each individual frequency. The
Multiple Frequency Statistics option also indicates the data used in the colored matrix plot
when multiple frequencies have been selected.

This right click menu option appears in theMatrix plot, regardless of whether you are in Table or
Plot view.
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The menu options are:

l Average – display the average of the matrix values across selected frequencies.
l Minimum – display the minimummatrix values across selected frequencies.
l Maximum – display the maximummatrix values across selected frequencies.

The selected information also appears in a tool-tip when you hover the cursor over a cell.

Highlight Min/Max
The Highlight Min/Maxmenu option determines whether the minimum and maximummatrix
entries should be highlighted in the matrix table and color plot view.

This right click menu option appears in theMatrix plot, regardless of whether you are in Table or
Plot view.

Select Transpose
The Select Transposemenu option determines whether transpose cells are highlighted along
with selected cells.

This right click menu option appears in theMatrix plot, regardless of whether you are in Table or
Plot view.
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Transpose cells are highlighted in Table or Plot view, as shown below.

Color Legend Attributes
The Color Legend Attributesmenu option allows you to change the granularity of the color
scheme and the value range for plots. This right click menu option appears in theMatrix plot.
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Alternatively, double-click the matrix plot's legend to open the Legend Attributes window.

Options include:

l Number of colors – allows you to select number of color entries in the legend (the number
of divisions between the start/end of the data range). This can be set to any discrete number
between 1 and 50.

l Automatic selection of min/max – check the Use the data minimum and maximum
check box to automatically select the data range using the minimum and maximum values
from either selected frequencies or all frequencies in the data set.

l Manually specified min/max – when the when the range is not automatically determined,
these fields permit users to manually enter hard values (e.g., for S parameter data
magnitude data, you could enter a minimum of 0 and a maximum of 1).

Using a standard range across all frequencies permits you to quantitatively compare plots, and
ndExplorer retains legend settings for each data-type and display-format pair.

Matrix Entries Plot Menu
On theMatrix plot, several new right-click menu options appear.
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TheMarker sub-menu provides commands for adding markers to plots.

The Add Notemenu option allows you to add a note to the plot.
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The note appears at the location you right-clicked. You can click and drag the note to a new
location, or double-click the note to change its color and font.

The View sub-menu provides commands for viewing, panning, zooming, and fitting elements to
your plot.
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Click Visibility to open the Active View Visibility window, where you can select the visibility of
traces, notes and legends.
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The Copy Bitmap Imagemenu option copies the plot to your clipboard. You can then paste it
into a graphics editor.

Exploring Network Data and Modifying the Display
Network Data Explorer allows you to view data and modify various aspects of the display,
including color plots, color coding, viewing across frequencies, and displaying individual
statistics. This section provides examples of Network Data Explorer capabilities:

l Viewing the S, Y, or Z Matrix for a Frequency
l Viewing a Color-coded Matrix Plot
l Displaying a Cell Graph Across All Frequencies
l Displaying Matrix Statistics by Frequency
l Displaying Individual Statistics for All Frequencies
l Creating a Statistics Plot
l Comparing Variations

Viewing a Matrix Table
To view the S, Y or Z matrix:

1. On the NDE ribbon, clickMatrix.
2. Click the Table check box.
3. Use the Parameter type drop-down menu to select S parameter, Y parameter, Z

parameter, or another choice.
4. Choose a format from the drop-down menu (e.g., dB or Mag).
5. From the Cell and Frequency Selection pane, select frequencies to display or click the

Select All check box on the NDE ribbon to select all frequencies. The S, Y, or Z matrix
displays.
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6. Hover over a cell to see more information in a tool tip.
7. Right click to see a right click menu with other commands.

Maximum values are highlighted in red stripes. If Select Transpose is enabled, transposes are
highlighted in red stripes as well.

Minimum values are highlighted in blue stripes.

Selected cells appear in solid blue. If Select Transpose is enabled, the transpose is highlighted
in blue as well.

Double-clicking a cell switches to a matrix cell view, in which values for all frequencies for that
cell are displayed. The double-clicked frequency is highlighted with solid red shading

Complex values are compared using their modulus. When multiple frequencies are selected, the
data display depends on the Multiple Frequency Statistics setting.

Viewing a Color-coded Matrix Plot
1. On the NDE ribbon, clickMatrix.
2. Use the Parameter type drop-down menu to select S parameter, Y parameter, Z

parameter, or another choice.
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3. From the Cell and Frequency Selection pane, select the frequencies you want to plot or click
the Select All check box on the NDE ribbon to select all frequencies.

4. Hover over a cell to see more information in a tool tip.
5. Right click to see a right click menu with other commands.

Matrix values display in a color-coded grid. If the selected Format is a complex value, only the
real component is used to determine the display color. When multiple frequencies or variations
are selected, the data display depends on the Multiple Frequency Statistics setting. Maximum
values are highlighted in red. Minimum values are highlighted in dark blue.

Hover the cursor over any cell to view information about it.

Click any cell to select it. Selected cells appear with a pink outline. If Select Transpose is
enabled, the transpose is selected in pink as well.

Double-click any cell to view a matrix cell plot in which all frequency values for that matrix cell are
displayed as a graph.

Displaying a Cell Graph Across All Frequencies
Network Data Explorer can plot a cell across all frequencies.
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1. On the NDE ribbon, click Sweep. The Data View Pane updates if appropriate.
2. Use the Parameter type drop-down menu to select S parameter, Y parameter, or Z

parameter.
3. From the Cell and Frequency Selection pane, select cells to display or click the Select All

check box on the NDE ribbon to select all cells.
4. To add a log scale to the X-axis, click Log X-Axis on the NDE ribbon.

5. To add a log scale to the Y-axis, click Log Y-Axis on the NDE ribbon.
6. Right click to see a right click menu with other commands.

Displaying Matrix Statistics by Frequency
Network Data Explorer can display various statistical measurements.

1. On the NDE ribbon:
a. ClickMatrix.
b. Click Table.
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c. Click Show Statistics.
2. From the Cell and Frequency Selection pane, select frequencies to display.

Click a column header to sort data by that column.

Hover the cursor over a cell to view information about it.

Only real (not complex) data formats are offered for statistical analysis. Passivity is only
available for S-parameter data (comparisons inactive). NTI refers to the number of trivial items;
for S-parameters, this includes all zeros and ones; for all other data (and data comparisons),
only zeros are counted as trivial. The minimum value for each column is highlighted in blue; the
maximum is highlighted in red.

Displaying Individual Statistics for All Frequencies
1. On the NDE ribbon:

a. Click Sweep.
b. Click Table.
c. Click Show Statistics.

2. From the Cell and Frequency Selection pane, select statistics to display. The information
displays in a table in the Data View pane.
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Selected statistics are displayed for all frequencies.

Passivity is only available for S-parameters (comparisons inactive).

For S-parameters, the Number of Trivial Items (NTI) includes all values of 0 and 1. For other
data and data comparisons, only values of 0 are counted as trivial.

Creating a Statistics Plot
Network Data Explorer can display a graph of selected statistical measures across all
frequencies.

1. On the NDE ribbon:
a. Click Sweep.
b. Click Show Statistics.

2. From the Cell and Frequency Selection pane, select statistics to display. The selected
statistics are plotted.
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Hover the cursor over a statistic to view more information about it.

Passivity is only available for S-parameters (comparisons inactive).

For S-parameters, the Number of Trivial Items (NTI) includes all values of 0 and 1. For other
data and data comparisons, only values of 0 are counted as trivial.

Comparing Network Data
Network Data Explorer can compare variations for two network data sets that are the same size.

1. On the NDE ribbon, click Sweep.
2. From the Network Data Selection pane, select exactly two data sets.
3. On the NDE ribbon, click Compare Data.
4. From the Cell and Frequency Selection pane, select which cells you want to compare . For

each value along the X-axis, the Y-axis values are subtracted, one from the other, to create
the comparison plot. The second selected data is subtracted from the first selected data.

5. Optionally, check Show Statistics to show values applied to all cells and all frequencies
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It is not possible to compare a data set against itself unless the data set has been cloned. Then,
you can compare the original data set to the clone.

Traces for a given cell or statistical measure are displayed for all data sets; you can use tool tips
to distinguish between them.

If a single cell or statistical measure is displayed, different colors are used for each data trace. If
multiple cells or statistical measures are selected, a single color is used for all data traces for
each cell or statistical measure.

In a data comparison, traces are shown for all selected data sets. This is true for both cell and
statistical traces.

If dB format is shown, you can either subtract values before or after applying the dB function.
See: Display Format to make this choice.

Causality Checking and Plots
Network Data Explorer can perform a causality check on S-parameter data from any source
(solution or file), and provide plots of the results in various formats.

When S-parameter data is loaded into Network Data Explorer, the Causality button is enabled.

1. On the NDE ribbon, click Causality. The Causality Options dialog box opens.

2. Enter a Causality tolerance and clickOK to start the causality check. Depending on the
size of the S-parameter data, the causality check may take several minutes to complete.
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The check's status displays in the Message Manager.

When the check completes, the Message Manager updates to display a summary of results.

Reconstruction Error Tolerance – Causality of a frequency response is determined by
calculating the generalized Hilbert transform of the data at all frequencies. A causal frequency
response is equal to its generalized Hilbert transform. The reconstruction error is the difference
between the tabulated data and its transform at a given frequency. The message shows the
maximum reconstruction error tolerance for a causal frequency response. The default tolerance
of 0.01 is equal to the state-space fitting tolerance.

Maximum Causality Error – The maximum causality error for all port pairs and all frequencies,
along with the matrix indices (port numbers) where the maximum noncausality occurs. A
noncausal response is one where all matrix entries can be conclusively analyzed, and at least
one entry exceeds the causality tolerance. The maximum reconstruction appears first, followed
by port numbers in brackets (e.g., [port number, port number]). When all results are conclusive
but no matrix reconstruction error exceeds the tolerance, the maximum causality error is
reported as zero, and no matrix entry is listed.

If the data does not contain enough frequency points to determine whether the data is or is not
causal, the Messages Pane will note an inconclusive result. Network Data Explorer will also
report the data set as inconclusive if any cells are inconclusive, even if other entries exhibit
causality violations.

To see the plotted results of the causality check:

1. On the NDE ribbon, click Causality Reports.
2. Either click theMatrix icon or select Causality violation in the Parameter type drop-down

menu.
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3. A rectangular plot displays, with dimension N x N and color-coding to indicate the causality
status of each port pairing.

In this plot, the cells go from (Port 1, Port 1) at the upper-left area to (Port N, Port N) at the lower-
right corner. The result shows the causality over all frequencies in the data. In this example, the
matrix is asymmetric, so that S12 is noncausal, while S11, S21, and S22 are causal.

To see the details for each frequency, click the Table check button on the NDE ribbon.
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To plot the reconstructed frequency response generated by the causality checker:

1. On the NDE ribbon, click Causality Reports.
2. Either click the Sweep icon or select Reconstructed Data in the Parameter type drop-

down menu.
3. From the Format drop-down menu, select an appropriate format. dB is selected by default.

The plot appears, showing the reconstruction error at each frequency divided by the
tolerance.
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The reconstruction error ratio for parameter S12 is positive for frequencies less than about
680MHz, indicating a broad range of noncausal behavior.

4. To compare the real part of the reconstructed data to the real part of the actual data, set the
Format to Real.
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For a causal frequency response, the actual data (solid line) will be within the upper and
lower bounds of the reconstruction (dotted lines) at all frequencies.

5. To compare the imaginary part of the reconstructed data to the imaginary part of the actual
data, set the Format to Imaginary.
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For a causal frequency response, the actual data (solid line) will be within the upper and
lower bounds of the reconstruction (dotted lines) at all frequencies.
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6. To view the frequency-dependent discretization error, set the Format to Discretization.

The discretization error is the error that is due to the fact that the data are available only at
discrete frequencies rather than for a continuous spectrum. A discretization error near or
greater than the causality tolerance renders the causality check inconclusive. Data at more
frequencies could reduce the discretization error and render the analysis conclusive. This
set of data exhibits low discretization errors (<<0.01) at all frequencies, and the causality
check is conclusive (conclusively noncausal in this example).

Multithreading
By default, multithreading (execution on multiple cores) is enabled for Causality Checking and
Macro Model export. Multithreading saves significant time in the Causality Check calculation,
and improves the time for other state-space fitting operations. See Technical Notes.

The Cores field in the Network Data Explorer Control Pane defaults to half the number of cores
detected on your computer.

For best performance, disable hyper-threading on your computer. When hyper-threading is
enabled, the number of cores includes the physical cores and an equal number of logical cores.
With hyper-threading disabled, the display shows only half the number of physical cores.
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To disable multithreading, uncheck the check box.
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8 - Viewing and Exporting Plots in SI Xplorer
After you use the ImpedanceWizard, results appear in the Plots and Messages pane:

Viewing and Exporting Impedance Plots
Prerequisites:

l Use the ImpedanceWizard to calculate trace width/pitch, impedance, or differential
impedance.

Impedance plots update as you change inputs in the Impedance Wizard pane and as you
change any settings underneath the plot. The table to the right summarizes the configuration. To
display more than one dataset, enable Preserve Plots to keep any plotted data displayed even
after you make a new calculation.

Important:

To see dynamic plot changes, Enable Dynamic Updatemust be enabled in the
Impedance Wizard pane.

For more details about these plots, see: Calculating Impedance, Calculating Differential
Impedance, and Calculating Trace Width/Pitch.

To export an impedance plot from SI Xplorer:
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1. Use the tabs at the top to select a plot for display.
2. ClickGenerate.

Viewing and Exporting Insertion/Return Loss and Time
Domain Crosstalk Plots
Prerequisites:

l Use the ImpedanceWizard to calculate trace width/pitch, impedance, or differential
impedance.

To calculate and plot IL/RL/FEXT/NEXT:

1. From the Plots window, select theW-Element Plots tab:

2. Use the IL/RL and FEXT/NEXT tabs to choose a plot:

The selected plot displays:

3. Adjust the settings as appropriate:

For IL/RL plots, you can adjust the Tline Length or click Set frequency range to change
the frequency range of the plot.

For FEXT/NEXT plots, you can adjust the Tline length (trace length); edit the Rise time,
Stop time, and peak Voltage of the driver attached to the aggressor net; or modify the
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driver Input Impedance value. This impedance is also used to terminate all transmission
lines in the specified cross-section.

Selecting the Preserve Plot check box allows you to display previous plots while computing
additional plots.

If you wish to export plot data, click Export Options:
l For IL/RL plots, you can choose Export w-element schematic to circuit (in *.aedt
format) or Export touchstone file.

l For FEXT/NEXT plots, you can choose Export w-element schematic to circuit (in
*.aedt format) or Export .csv file.

If you change values and need to regenerate the plot, click Recompute.

Right-clicking within the plot enables additional plotting actions.

Changing Plot Display Options
You can change the way SI Xplorer displays plots.

Double-clicking within the plot enables opens the Properties window on the relevant tab.

Tabs include:

l Attributes – display options for the selected plot element. This tab only displays when a plot
element is selected.

l Cartesian – display options for the coordinate system.
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l General – display options for the plot's background colors and number formatting.
l Grid – display options for grid visibility and coloring.
l Header – display options for the header's font and formatting.
l Legend – display options for the legend's background colors, grid, and formatting.
l X Axis – display options for the X axis.
l X Scaling – X axis display options for minimum value, maximum value, and scaling.
l Y Axis – display options for the Y axis.
l Y Scaling – Y axis display options for minimum value, maximum value, and scaling.

Each tab allows you to specify display units, colors, fonts, and scaling for the relevant plot
element. Select Show Hidden on any tab to view additional options for that tab.

Additional Plotting Actions
Right-clicking a plot in SI Xplorer enables options for adding markers and notes, changing the
display, and editing settings.

Menu options include:

l Marker – Submenu containing marker options.
l Add Marker – transforms the cursor into a crosshair, allowing you to click and place a
marker at an appropriate point. When you are finished placing markers, right-click and
select End Marker Mode. Markers appear on the plot and in a table showing their
coordinates.

l Add Delta Marker – transforms the cursor into a crosshair, allowing you to click and
place a marker at an appropriate point. You must then click a second point, and a table
appears showing deltas and slopes. When you are finished placing markers, right-click
and select End Marker Mode.

l Export Marker Table – exports the marker coordinate table in *.csv or *.tab format.
l Export Delta Marker Table – exports the delta marker table in *.csv or *.tab format.
l Add Maximum – places a marker at the maximum value along the X-axis.
l Add Minimum – places a marker at the minimum value along the X-axis.
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l Add X Marker – adds up to 10 movable markers as vertical lines rising from the X axis.
Each added marker has its own color and editable properties. To move an X marker, click
on the X label and drag it to an appropriate location. The label at the bottom of the line
gives the X coordinate, and flag on the vertical line identifies the Y coordinate.

l Bring X Marker Into View – when one or more X markers is not visible, this option allows
you to bring them into view.

l Add Y Marker – adds up to 10 movable markers as horizontal lines extending from the Y
axis. Each added marker has its own color and editable properties. To move a Y marker,
click on the Y label and drag it to an appropriate location. The label at the bottom of the
line gives the Y coordinate, and flag on the vertical line identifies the X coordinate.

l Bring Y Marker Into View – when one or more Y markers is not visible, this option allows
you to bring them into view.

l Next Peak – selects the next high point along the X-axis, before the next dip.
l Next Minimum – selects the next lowest point along the X-axis, after the next high point.
l Previous Peak – selects previous next high point along the X-axis, before the previous
dip.

l Previous Minimum – selects the previous lowest point along the X-axis, after the
previous high point.

l Go to Start – selects the first marker on the plot, along the X-axis.
l Go to Previous – selects the previous marker on the plot, along the X-axis.
l Go to End – selects the last marker on the plot, along the X-axis.
l Next Curve – selects the next curve on the plot, based on the order in the legend.
l Previous Curve – selects the previous curve on the plot, based on the order in the
legend.

l Clear All – removes all markers from the plot.
l Add Note – Allows you to add a note to the plotting area. You can click and drag the note to
your appropriate location.

Select the note and press the Delete key to remove it.
l View – Submenu containing view options.

l Pan – Changes the cursor to move the plot within the window. Right-click and deselect
Pan to exit this mode.

l Zoom – Changes the cursor to zoom the entire plot in or out within the window. Right-
click and deselect Zoom to exit this mode.

l Zoom In / Zoom Out – Changes the cursor to a crosshair. Click a point in the plot to
zoom in to it or out from it. Right-click and deselect Zoom In or Zoom Out again to exit
this mode.

l Fit All / Fit X Window / Fit Selection / Best Vertical Fit – Automatically scales the plot
to an appropriate size.
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l Show / Hide Selection / Show All –When a dataset is selected on the plot, Show /
Hide Selection allows you to hide or show that dataset. Select Show All to return to the
original plot displaying all datasets.

l Visibility – Opens a window where you can set the visibility of traces, notes, and legends.
l Animate – This functionality is not yet present in the plot window.

l Edit – Submenu containing edit options.
l Copy Settings – Copies the display settings in text format for use in scripts.
l Reset Settings – Resets the plot window to its original view, including scale, colors, etc.
l Delete – Allows you to delete a marker.
l Properties – Opens the Properties window, where you can change display options.

l Copy Bitmap Image – Copies a bitmap image of the plot to the clipboard for pasting into a
graphics editor or other compatible software.
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9 - Technical Notes
This section contains technical notes on the following topics:

Huray Surface Roughness Model

Huray Surface Roughness Model
Surface roughness can increase conductor power losses by more than two times the loss
associated with smooth conductors. In SIwave, a modification of the standard real-valued Huray
surface roughness model is implemented to accurately account for these losses in both the
frequency and time domains.

This modification fixes a causality problem with the original Huray model by adding some
frequency-dependent reactance to the roughness-enhanced surface impedance. The purpose
is to provide a complex-valued causal analytic model that exactly matches the loss results of the
original model but is also suitable for time domain computations. The original Huray model was
limited to calculations in the frequency domain and did not account for the effects of roughness
on the phase of the transmitted signal. These limitations have been eliminated. The enhanced
causal model provides accurate broad-band modeling of the losses in very rough copper foils
(typically used in printed circuit board manufacturing), as did the original model, but also
accurately predicts increased phase delay due to the surface roughness. because of its
suitability for time domain computations.

Essentially, the smooth surface impedance (Zsmooth) is increased by a complex “Huray” factor
(Hc), a function of frequency, given by the following formula:

where:

l ω  is the frequency in radians/second

l ω0  is a corner frequency:

l K  is a derived constant used to simplify the equation:
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l a  is the radius of a spherical nodule

Note:

a and SR are the two parameters you must enter in the Surface Roughness
Model dialog box when you select the Huray option:

l μ  is the permeability of free space = 4π * 1e-7 H/m

l σ  is the electrical conductivity in Siemens/m
l N  is the number of nodules
l Af  is a unit cell area

The following image of a magnified rough copper surface helps to clarify the a, Af , andN
parameters previously defined:
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Note:

For more information about this complex causal Huray model – its necessity,
background, derivation, proof of accuracy, and consistency with the original real-
valued model – see the following article:

l J. Eric Bracken, ANSYS Inc., "A Causal Huray Model for Surface Roughness",
DesignCon 2012, January 2012

This article is available from various online sources.

Once the Huray surface roughness factor is determined, the rough surface impedance (Zrough)
is determined as follows:
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